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Archivist for Excel

© 1996 Josef J. Polak. All rights reserved. 

All other product names are copyright and trademarks/tradenames of their respective owners.

This workbook lets you install Archivist Version 1.22,
the Document Zip Magager for Microsoft Excel 5.0.

To install, choose button Begin Installation.
To display the documentation, choose the button, or click the sheet tab.
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What is Archivist

Archivist is also avaliable for Microsoft Word 6.0.

Installation

Microsoft Excel’s files may take a lot of space on the hard disk of your computer. Since you  probably 
work with only a few workbooks at a time, you can recover half or even more of the disk space by 
compressing the individual files into an archive. Of course, you could store your workbooks on 
diskettes but, compared to the hard disk, diskettes are less convenient to use.

Archivist is an add-in for Microsoft Excel 5.0. It allows you to compress files into archive, list the 
contents of an archive, and restore files with the ease of point-and-click, without leaving Excel.
When you compress a workbook, you may expect 50% to 75% reduction in the amount of disk space 
it occupies. Please note that you may use Archivist to compress not only MS Excel workbooks but 
other files as well.

The add-in uses two well respected and widely used programs, PKZIP and PKUNZIP. These are 
available for downloading on virtually all bulletin boards (BBS) and on-line services.

Please note:

        You must have programs PKUNZIP.EXE and PKZIP.EXE installed on you computer.
        The PATH command in your AUTOEXEC.BAT file should include the directory in which
        these programs reside.
        Shareware versions of these programs are available on many bulletin boards or from
                PKWARE, Inc.
                9025 N. Deerwood Drive
                Brown Deer, WI 53223

Installation starts when you choose button Begin Installation in this workbook.

The installation will copy add-in Archivist into the Microsoft Excel's startup directory on your
hard disk (or into another directory you specify).

It will also copy two files, DZXL5ZP.PIF and DZXL5UNZ.PIF, into your Windows’ directory.
When Archivist is available, command Document Zip Manager will appear on the Tools menu,
and on the File menu when no documents are open.
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About Archivist





 The opportunity to order the latest versions of macro source code.
 The satisfaction of knowing that you are supporting the development of affordable software.

Archivist is also avaliable for Microsoft Word 6.0.

Technical support by telephone or mail. You can get help with any questions or problems you 
encounter in using Archivist.
The opportunity to order the latest version of Archivist and its upgrades on disk directly from 
the author.

Archivist is shareware. Archivist is not free. If you find Archivist useful and continue to use it, you 
are encouraged to register your copy. Registration fee is $15 U.S., payable to:
        Josef J. Polak
        39 Greylock Road
        Newton, MA 02165
Please include the name of the person to whom Excel is licensed (as it appears in Help, 
About Microsoft Excel…).

The user who registers receives several benefits:

Distribution
The Archivist software, and the associated documentation are © 1996 Josef J. Polak.You may
distribute this software as long as the following files are included:
                AREG.TXT
                DZM_XL50.XLA
                DZXL5UNZ.PIF
                DZXL5ZP.PIF
                FILE_ID.DIZ
                INST_D2M.XLA
                INST_DZM.XLS
                PACKING.LST
                README.TXT
All of the above files must be combined into a single ZIP file (or other compression format) for
distribution. Beyond a fee for the reproduction and media cost, no fee may be charged for
distribution of this software.

DISCLAIMER
This software is provided on an “as is” basis without warranty of any kind, expressed or implied, including but
not limited to the implied warranties of merchantability and fitness for a particular purpose. The person using
the software bears all risk as to the quality and performance of the software. The author will not be liable for
any special, incidental, consequential, indirect or similar damages due to loss of data or any other reason, even
if the author or an agent of the author has been advised of the possibility of such damages. In no event shall the
author's liability for any damages ever exceed the price paid for the license to use the software, regardless of
the form of the claim. This software remains the property of the author and may not be modified in any way.
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Managing Documents — Instructions

How to move documents into archive (action Move…)
u     Click on option button Move file(s) into archive. The list box shows all files in the directory.
u     Select a file in list box Files Available:, click on the Select >> button. (Shortcut: double-click
        the left mouse button on the name of the file.) The add-in adds the file on its list of files to be
        moved, shows the name in list box Selected Files: and removes it from Files Available:.
        Select other files you wish to archive.
        If you wish to change your selection, select a file in list box Selected Files. The button text
        “Select >>“ changes to “<< Remove.”  Clicking on this button removes the file from the list of
        files to be moved and places its name back into Files Available:.
u     Click on the OK button and confirm the move. The add-in moves the selected files into the
        archive, removes them from your disk and, when you add a new file to the archive, asks you
        “Would you like to generate contents list…?” You should click on the Yes button when you
        create a new archive. This list is a file with extension .Z_L, which contains the “table of
        contents” of the archive. Archivist uses this list when restoring and deleting files (see
        Restore below). Once you create the contents list, Archivist will maintain it for you
        automatically. You should keep this file on your disk.
u     If you wish to move all files in the current directory into the archive, click on the All Files >>
        button, then on the OK button. Note, that archive files (*.ZIP) and list files (*.Z_L) will not be
        archived.
This action is available only if the current d

How to retrieve documents from archive (action Restore…)
u     Click on option button Restore archived file(s). The list box now shows only the files on the
        list generated after the most recent move and/or delete (see Move and Delete).
u     Select a file in list box Archived Files on List (.Z_L):, click on the Select >> button. The
        add-in displays the file in list box Selected Files:. Select other files you wish to restore.
u     Click on the OK button and confirm the restore.
u     If you wish to restore all files from the archive into the current directory, click on the
        All Files >> button, then on the OK button.
This action is available only if the current directory contains at least one archive and the selected
archive has a corresponding list file. When there is no list file, the name of this action changes
to “Restore all archived files."

How to start Archivist
If you did not install Archivist into your startup directory, open DZM_XL50.XLA. (Note: Use the Add-
Ins... command (Tools menu) to make Archivist automatically available when you start Excel.)
u     From the Tools menu (or from the File menu when no documents are open), choose
        Document Zip Manager. Archivist displays its main dialog box window.

The add-in automatically looks for archives (files with the extension .ZIP) in the current directory
and selects the first one it finds. You may choose another archive (see “How to select another
archive in the current directory” below). If it does not find any archive, it will inform you that
archiving will create archive DOCS.ZIP.
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How to retrieve documents from archive (action Restore…)
u     Click on option button Restore archived file(s). The list box now shows only the files on the
        list generated after the most recent move and/or delete (see Move and Delete).
u     Select a file in list box Archived Files on List (.Z_L):, click on the Select >> button. The
        add-in displays the file in list box Selected Files:. Select other files you wish to restore.
u     Click on the OK button and confirm the restore.
u     If you wish to restore all files from the archive into the current directory, click on the
        All Files >> button, then on the OK button.
This action is available only if the current directory contains at least one archive and the selected
archive has a corresponding list file. When there is no list file, the name of this action changes
to “Restore all archived files."

How to remove documents from archive (action Delete…)
u     Click on option button Delete…. The list box now shows only the files on the list generated
        after the most recent move and/or delete.
u     Select a file in list box Archived Files on List (.Z_L):, click on the Select >> button. The
        add-in displays the file in list box Selected Files:. Select other files you wish to delete.
u     Click on the OK button and confirm the delete.
This action is available only if the current directory contains at least one archive and the selected
archive has a corresponding list file.

How to update all documents in archive (action Update…)
u     Click on option button Update…. List box Archived Files: is dimmed and shows only the files
        on the list.
u     Click on the OK button and confirm the update. Archivist will move into the archive all files in
        the current directory that meet the following three conditions:
                1. A file of the same name already is in the archive.
                2. The file on you hard disk is newer than that in the archive.
                3. The file is not being used by an application. For instance, Archivist cannot update
                    a workbook which is open in Excel.
This action is available only if the current directory contains at least one file.

What is the difference between “Update all files…” and moving all files
When you select all files for action “Move file into archive,” the add-in moves all files in the
current directory into the archive and removes them from your disk, excluding files with
extensions .ZIP (archives) and .Z_L (list files).
Action “Update all files which already are in archive” replaces all files in the archive with newer
ones from the current directory on your disk. The add-in then removes from your disk only those
files which are in the archive. In another words, the add-in will not add new files to archive. It will
move file into archive only if a file with the same name already exists in the archive.

How to name and change archives
Archivist uses the name DOCS.ZIP if the current directory does not contain an archive. You may
select another name:
u     Click on the Name Archive… button and enter a name for the archive.
This button is available only if the current directory contains at least one file.

How to select another archive in the current directory
Archivist automatically selects the first archive it finds in the current directory. If a directory
contains several archives, you may select another archive:
u     Select an archive in list box Archives (*.ZIP): and click on the OK button. (Shortcut: double
        click the left mouse button on the name of the archive.)
You may also use the Name Archive… button to enter the name of an existing archive or name
for a new archive.
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Messages
The following table lists messages and problems you might encounter.

MESSAGE or PROBLEM CAUSE REMEDY

How to select another archive in the current directory
Archivist automatically selects the first archive it finds in the current directory. If a directory
contains several archives, you may select another archive:
u     Select an archive in list box Archives (*.ZIP): and click on the OK button. (Shortcut: double
        click the left mouse button on the name of the archive.)
You may also use the Name Archive… button to enter the name of an existing archive or name
for a new archive.

How to change directory
u     Click on the Change Directory button. The button text changes to “Show Files.”
u     Choose another directory in list box Directories: and click on the OK button. Repeat until you
        reach the desired directory. (Shortcut: double click the left mouse button on the name of the
        directory.) List box Archives (*.ZIP): will show names of all archives in each directory.
u     Click on the Show Files button to return to the main dialog box window. Archivist
        automatically selects the first archive it finds in the new directory.
u     You may also select an archive in list box Archives (*.ZIP): and click on the OK button (or
double click the left mouse button on the name of the archive).
If you change to a directory in which there are no archives, archiving (Move…) will create one.

How to change drive
The add-in itself cannot change drive. However, if you wish archive files located on another drive,
switch to that drive in Microsoft Excel first, before running Archivist:
u     From the File menu, choose Open….
u     In drop-down list box Drives: select the drive you wish to use.
u     Click on the Cancel button (or press the Esc key).

The check box “Restore Directory…”
Archivist’s dialog box contains check box labeled “Restore Directory Structure Stored in Archive.”
The check box and the text will be “grayed” (disabled). This option has no meaning for archives
created by archivist. However, since you may have other archives (ZIP files) on your hard disk, it
is included for you convenience.
Technical footnote:
This check box has meaning for archives created (PKZIP) with options -r, -p|P. If it is checked,
Archivist will restore (PKUNZIP) files with the option -d.

Cautions
u     Do not attempt to archive files while they are “open,” for example, a MS Excel workbook,
        while you are working with it.
u     Do not attempt to archive any file whose name starts with the character “~” (tilde).
u     Do not archive any .INI file, unless you are certain that they will not be needed.  Same
        caution applies to .EXE, .COM, .DLL, .DRV, .REG, .386 and other system files.
u     You may, however, archive some system files which you seldom use, for example, TrueType
        font files (.TTF)
u     Never archive AUTOEXEC.BAT, CONFIG.SYS, WIN.INI and SYSTEM.INI.
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Archive x.ZIP is not present in… No archives in the current directory. Archiving will create it.
There are no files to be archived. The directory is empty. None
The name is not valid. Choose another name.

Cannot archive into itself! Attempt to archive x.ZIP into itself. None
The add-in is completing some task. None

File(s) will not restore. Your disk might be full. Remove some files.
The archive may be damaged.

The file may be marked as “read-only.”

Your disk might be full. Remove some files.
File x.Z_L is not a valid list. You removed all files from archive x.ZIP Generate new after move.

The file is damaged (corrupted or lost data) Generate new.
x.Z_L was created by another application. Choose another name.
The archive may be damaged.

You entered a name which is not a valid MS-
DOS file name.

You have to wait
about x second(s).

I moved a file into archive, but
the file is still on my hard disk.

Restore all files, then
delete the archive.
Clear the attribute (use
DOS command attrib).

I asked for a new list, but I still
get “…is not a valid list.”

Restore all files, then delete
the archive.
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How to move documents into archive (action Move…)
u     Click on option button Move file(s) into archive. The list box shows all files in the directory.
u     Select a file in list box Files Available:, click on the Select >> button. (Shortcut: double-click
        the left mouse button on the name of the file.) The add-in adds the file on its list of files to be
        moved, shows the name in list box Selected Files: and removes it from Files Available:.
        Select other files you wish to archive.
        If you wish to change your selection, select a file in list box Selected Files. The button text
        “Select >>“ changes to “<< Remove.”  Clicking on this button removes the file from the list of
        files to be moved and places its name back into Files Available:.
u     Click on the OK button and confirm the move. The add-in moves the selected files into the
        archive, removes them from your disk and, when you add a new file to the archive, asks you
        “Would you like to generate contents list…?” You should click on the Yes button when you
        create a new archive. This list is a file with extension .Z_L, which contains the “table of
        contents” of the archive. Archivist uses this list when restoring and deleting files (see
        Restore below). Once you create the contents list, Archivist will maintain it for you
        automatically. You should keep this file on your disk.
u     If you wish to move all files in the current directory into the archive, click on the All Files >>
        button, then on the OK button. Note, that archive files (*.ZIP) and list files (*.Z_L) will not be
        archived.
This action is available only if the current d

How to retrieve documents from archive (action Restore…)
u     Click on option button Restore archived file(s). The list box now shows only the files on the
        list generated after the most recent move and/or delete (see Move and Delete).
u     Select a file in list box Archived Files on List (.Z_L):, click on the Select >> button. The
        add-in displays the file in list box Selected Files:. Select other files you wish to restore.
u     Click on the OK button and confirm the restore.
u     If you wish to restore all files from the archive into the current directory, click on the
        All Files >> button, then on the OK button.
This action is available only if the current directory contains at least one archive and the selected
archive has a corresponding list file. When there is no list file, the name of this action changes
to “Restore all archived files."
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Action “Update all files which already are in archive” replaces all files in the archive with newer
ones from the current directory on your disk. The add-in then removes from your disk only those
files which are in the archive. In another words, the add-in will not add new files to archive. It will
move file into archive only if a file with the same name already exists in the archive.

How to name and change archives
Archivist uses the name DOCS.ZIP if the current directory does not contain an archive. You may
select another name:
u     Click on the Name Archive… button and enter a name for the archive.
This button is available only if the current directory contains at least one file.

How to select another archive in the current directory
Archivist automatically selects the first archive it finds in the current directory. If a directory
contains several archives, you may select another archive:
u     Select an archive in list box Archives (*.ZIP): and click on the OK button. (Shortcut: double
        click the left mouse button on the name of the archive.)
You may also use the Name Archive… button to enter the name of an existing archive or name
for a new archive.
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How to select another archive in the current directory
Archivist automatically selects the first archive it finds in the current directory. If a directory
contains several archives, you may select another archive:
u     Select an archive in list box Archives (*.ZIP): and click on the OK button. (Shortcut: double
        click the left mouse button on the name of the archive.)
You may also use the Name Archive… button to enter the name of an existing archive or name
for a new archive.

How to change directory
u     Click on the Change Directory button. The button text changes to “Show Files.”
u     Choose another directory in list box Directories: and click on the OK button. Repeat until you
        reach the desired directory. (Shortcut: double click the left mouse button on the name of the
        directory.) List box Archives (*.ZIP): will show names of all archives in each directory.
u     Click on the Show Files button to return to the main dialog box window. Archivist
        automatically selects the first archive it finds in the new directory.
u     You may also select an archive in list box Archives (*.ZIP): and click on the OK button (or
double click the left mouse button on the name of the archive).
If you change to a directory in which there are no archives, archiving (Move…) will create one.

How to change drive
The add-in itself cannot change drive. However, if you wish archive files located on another drive,
switch to that drive in Microsoft Excel first, before running Archivist:
u     From the File menu, choose Open….
u     In drop-down list box Drives: select the drive you wish to use.
u     Click on the Cancel button (or press the Esc key).

The check box “Restore Directory…”
Archivist’s dialog box contains check box labeled “Restore Directory Structure Stored in Archive.”
The check box and the text will be “grayed” (disabled). This option has no meaning for archives
created by archivist. However, since you may have other archives (ZIP files) on your hard disk, it
is included for you convenience.
Technical footnote:
This check box has meaning for archives created (PKZIP) with options -r, -p|P. If it is checked,
Archivist will restore (PKUNZIP) files with the option -d.

Cautions
u     Do not attempt to archive files while they are “open,” for example, a MS Excel workbook,
        while you are working with it.
u     Do not attempt to archive any file whose name starts with the character “~” (tilde).
u     Do not archive any .INI file, unless you are certain that they will not be needed.  Same
        caution applies to .EXE, .COM, .DLL, .DRV, .REG, .386 and other system files.
u     You may, however, archive some system files which you seldom use, for example, TrueType
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